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Gwarancja i odpowiedzialność 
Informacje zawarte w tej publikacji mogą ulec zmianie bez wcześniejszego powiadomienia. Firma 
GAMMA Medizinisch-wissenschaftliche Fortbildungs-GmbH nie udziela gwarancji żadnego rodzaju. 
Firma GAMMA zastrzega sobie jednoznacznie prawo do zmiany tej dokumentacji bez powiadamiania 
którejkolwiek ze stron. 

Firma GAMMA nie wyklucza, że w wyniku błędu systemu, serwisu lub użytkownika może wystąpić błąd 
obliczeniowy. W związku z tym lekarz zawsze powinien sprawdzać wyświetlane dane i obliczenia. 
Ostateczna decyzja w sprawie terapii i odpowiedzialność wobec pacjenta spoczywa każdorazowo na 
lekarzu. Firma GAMMA Medizinisch-wissenschaftliche Fortbildungs-GmbH nie ponosi żadnej 
odpowiedzialności. 
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1 Wstęp 

Dziękujemy za zaufanie i zakup naszego systemu CADIAX. Kupiliście najwyższej jakości wyrób techniki 
medycznej, rezultat ponad 25 lat doświadczenia w elektronicznej rejestracji torów ruchu stawów 
skroniowo - żuchwowych. 

Na kolejnych stronach chcielibyśmy ułatwić użytkownikowi poznanie urządzenia CADIAX i jego 
oprogramowania. 

1.1 Wyjaśnienie symboli użytych na opakowaniu i na urządzeniu 

 

Uwaga: zapoznaj się z dołączoną instrukcją. 

 

Uwaga: pole magnetyczne 

 

Część stosowana typu B 

 

Postępuj zgodnie z instrukcją 

 

Producent 

 

Data produkcji 

 

Numer seryjny 

 

Górny i dolny limit temperatury 

 

Górny i dolny limit wilgotności względnej 
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Górny i dolny limit ciśnienia atmosferycznego 

 

Odpady utylizować oddzielnie 

 

złącze płytki i rylca, prawe 

 

złącze płytki i rylca, lewe 

 

złącze przełącznika nożnego 

 

złącze USB 

 
prąd stały 

 

Nie siadać na urządzeniu 

 

Nie stawać na urządzeniu 

1.2 Ważne aspekty bezpieczeństwa 

 

Dla własnego bezpieczeństwa oraz dla bezpieczeństwa eksploatacji dokładnie 
przeczytaj tę instrukcję, zanim zaczniesz użytkować urządzenie. Zawsze postępuj 
zgodnie ze wszystkimi ostrzeżeniami w tej instrukcji i/lub tymi, które umieszczono na 
samym urządzeniu. 

1.2.1 Ogólne zasady bezpieczeństwa 

 

Urządzenie używaj w przestronnym pomieszczeniu, umożliwiając prawidłowe 
rozpraszanie ciepła. 

Nigdy nie używaj urządzenia w miejscach, w których do jego wnętrza może dostać się 
woda lub inna ciecz. 
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Urządzenie jest zasilane z komputera, do którego jest ono podłączone poprzez port USB. 
Podłączaj urządzenie tylko bezpośrednio do terminala USB komputera. Nigdy nie 
obsługuj urządzenia podłączonego do huba USB i nigdy nie używaj alternatywnych 
źródeł zasilania. 

Nigdy nie ustawiaj urządzenia w pobliżu pól potencjalnej interferencji 
elektromagnetycznej (głośników, telefonów komórkowych, sterylizatorów, itp.). 

Nigdy nie próbuj samodzielnie naprawiać urządzenia. Wszelkie naprawy muszą zostać 
wykonane przez upoważniony i przeszkolony personel serwisowy. 

W niżej wymienionych przypadkach odłącz urządzenie od komputera i skontaktuj się z 
wykwalifikowanym pracownikiem serwisu: 

• Jeśli woda lub inna ciecz dostanie się do wnętrza urządzenia 

• Jeśli urządzenie nie działa poprawnie, mimo stosowania się do instrukcji obsługi. 

• Jeśli urządzenie upadło lub została uszkodzona jego obudowa. 

• Jeśli urządzenie wygląda lub działa inaczej niż zwykle. 

Sprawdź, czy urządzenie stoi na gładkiej, równej powierzchni, która jest dłuższa i szersza 
niż samo urządzenie. 

Powierzchnia, na której stoi urządzenie musi być wystarczająco stabilna, ponieważ 
podczas wstrząsu lub upadku może ono zostać poważnie uszkodzone. 

Wybierając powierzchnię roboczą i/lub powierzchnię przechowywania, sprawdź, czy 
urządzenie nie jest narażone na znaczne zmiany temperatury lub wilgotności, na 
bezpośrednie światło słoneczne lub wysoką temperaturę. 

Sprawdź, czy urządzenie nie jest narażone na wstrząsy. 

Sprawdź też, czy przypadkowo nie pociągniesz za kabel (ryzyko wywrócenia). 

 

Nie siadaj na urządzeniu, ponieważ możesz w ten sposób poważnie je uszkodzić. 

 

Nie stawaj na urządzeniu, ponieważ możesz w ten sposób poważnie je uszkodzić. 
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1.2.2 Specjalne informacje dotyczące elektrycznych wyrobów medycznych 

1.2.2.1 Instalacja urządzenia CADIAX 

 

Jeśli komputer podłączony do urządzenia 
CADIAX znajduje się w pobliżu pacjenta, 
należy go sprawdzić pod kątem zgodności 
z normą EN 60601-1. 

Otoczenie pacjenta (w rozumieniu 
przepisów normy EN 60601-1) to obszar, 
w którym pacjent może celowo lub 
przypadkowo wejść w kontakt z: 

• częścią urządzenia/systemu 
medycznego lub 

• osobą, która używa lub dotyka części 
urządzenia/systemu. 

 

Definicja otoczenia pacjenta, zgodnie z normą EN 
60601-1 

Jeśli komputer podłączony do urządzenia CADIAX nie został wyprodukowany zgodnie z normą EN 
60601-1, należy go używać poza otoczeniem pacjenta. 

 

Jeśli taki komputer zostanie ustawiony w otoczeniu pacjenta, wówczas on sam i wszystkie inne 
urządzenia do niego podłączone (np. monitor) muszą posiadać izolację zgodną z normą EN 60601-1. 
Urządzenia zasilające należy podłączać poprzez medyczny transformator izolacyjny, a do sieci przez 
telefon komórkowy – poprzez medyczny izolator sieciowy. 

 

 

Otoczenie pacjenta 

Otoczenie pacjenta 

Sieć 

Sieć 

Kabel zasilający 

Kabel sieciowy 

Kabel USB 
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Urządzenie CADIAX nie może być obsługiwane w bezpośrednim pobliżu innych urządzeń ani stawiane 
na innych urządzeniach. W razie konieczności obsługiwania CADIAX w pobliżu innych urządzeń lub po 
ustawieniu go na innych urządzeniach, sprawdź, czy w tej konfiguracji systemowej urządzenie działa 
poprawnie. 

1.2.2.2 Obsługiwanie urządzenia CADIAX 

 

Włączaj tryb rejestracji w urządzeniu tylko po całkowitym zamontowaniu sensorów 
pomiarowych (płytek i rylców). 

Sprawdź, czy w czasie rejestracji ani Ty sam ani pacjent nie dotyka sensorów  

Zawsze wyłączaj tryb rejestracji przed odłączeniem płytek i rylców od łuku twarzowego. 

Gniazda sensorów z przodu urządzenia mają następujący układ: 

 

1: Prawy rylec 

2: Prawa płytka 

3: Lewa płytka 

4: Lewy rylec 

Gniazda przełącznika nożnego i złącze USB do podłączenia do komputera znajdują się z tyłu 
urządzenia. 

Stan urządzenia CADIAX pokazuje zielona kontrolka LED z przodu obudowy. Może ona pokazywać 
następujące stany: 

 

Kontrolka LED zapalona przez cały czas:  
Urządzenie gotowe do działania. 

 

Kontrolka LED miga z częstotliwością 5 Hz:  
Trwa pomiar. 

 

Kontrolka LED miga z częstotliwością 0,5 Hz:  
Błąd sprzętowy, nie można wykonać pomiaru. 

 

Kontrolka LED nie pali się:  
Urządzenie nie jest podłączone do komputera. 
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1.2.2.3 Zgodność elektromagnetyczna 

 

Urządzenia medyczne wymagają specjalnych środków ostrożności pod kątem tolerancji 
elektromagnetycznej. W związku z tym urządzenie CADIAX może zostać zainstalowane 
i uruchomione zgodnie z instrukcją zawartą w rozdziale „Zgodność elektromagnetyczna 
– wytyczne i deklaracja producenta” niniejszego podręcznika. 

Używaj wyłącznie akcesoriów, które posiadają jednoznaczne dopuszczenie do pracy z 
urządzeniami CADIAX. Używanie innych akcesoriów, zwłaszcza kabli dłuższych niż 
długość kabla zapisana w niniejszej instrukcji obsługi może prowadzić do zwiększonej 
emisji interferencji lub do zmniejszenia odporności na interferencje urządzenia CADIAX. 

Przenośne i mobilne urządzenia telekomunikacyjne, np. telefony komórkowe, telefony 
bezprzewodowe, komputery i laptopy z uruchomioną siecią WLAN itp., mogą mieć 
niekorzystny wpływ na elektroniczne urządzenia medyczne. Nie używaj urządzenia 
CADIAX w pobliżu tych potencjalnych źródeł interferencji i sprawdź, czy stosujesz 
zalecenia dotyczące bezpiecznych odległości opisanych w rozdziale „Zalecane 
odległości minimalne od przenośnych i mobilnych urządzeń telekomunikacyjnych” 
niniejszego podręcznika. 

1.2.2.4 Podłączanie innych urządzeń 

 

Urządzenia podłączone do interfejsów analogowych lub cyfrowych muszą być 
certyfikowane, aby spełnić specyfikację odpowiedniej normy EN (np. EN 60950 dla 
urządzeń przetwarzających dane lub EN 60601 dla elektrycznych wyrobów 
medycznych). Oprócz tego cała konfiguracja musi spełniać wymogi normy EN 60601-1 
dla systemów. Każdy, kto składa uzupełniające się urządzenia do wprowadzania sygnału 
lub urządzenia odbiorcze, jako konfigurator systemu odpowiada za zgodność z 
przepisami normy EN 60601-1. 

1.2.3 Przeciwwskazania – ograniczenia zastosowania 

 

W trakcie użytkowania systemu CADIAX następujące okoliczności mogą uniemożliwić 
lub ograniczyć jego zastosowanie: 

• Zdolności umysłowe 

Pacjenci, którzy nie są w stanie prawidłowo zrozumieć albo zastosować się do poleceń 
dentysty (np. jak przesunąć żuchwę, itp.) ze względów fizjologicznych lub 
psychologicznych. 

• Ogólne obrazy kliniczne: 

Pacjenci cierpiący na choroby, które nie pozwalają na zamocowanie łuku twarzowego 
do celów rejestracji. Choroby te mogą być natury fizycznej lub psychicznej (np. 
spastyka, epilepsja, klaustrofobia, uraz lub choroba czaszki lub tkanek miękkich 
czaszki, uszu, itp.). 

• Stomatologiczne obrazy kliniczne: 

Pacjenci z chorobami zębów i przyzębia, które wykluczają mocowanie uchwytu 
(paradontoza, luźno osadzone zęby, uszkodzenia tkanki twardej zęba, zmiany 
śluzówki w jamy ustnej lub gardła, itp.) 

• Określone choroby w obszarze uszu: 

Pacjenci z chorobami w obszarze uszu, które wykluczają mocowanie łuku twarzowego 
w kanale słuchowym (np. bolesne stany zapalne, szumy uszne, ból ucha, itp.) 

• Ból mięśni w obszarze głowy i szyi:  

Pacjenci z silnym bólem mięśniowym w obszarze głowy i szyi, którzy nie są w stanie 
utrzymać łuku twarzowego podczas badania. 

• Pacjenci w wieku między 0 a 9 lat: 

Doświadczenie pokazuje, że dzieci potrafią zastosować się do instrukcji dentysty tak, 
aby z sukcesem przeprowadzić badanie dopiero w okolicach 10 roku życia. Oprócz 
tego, zamocowanie uchwytu mogą utrudniać zęby mleczne. 
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• Osoby z założonymi implantami 

Pacjenci z aktywnymi implantami (np. rozrusznik serca) powinni być ostrożnie 
poddawani oddziaływaniu systemu sensor-magnes CADIAX, ponieważ końcówka 
rylca, do którego przymocowano magnes może znaleźć się w pobliżu takiego implantu. 

1.2.4 System sensor-magnes 

 

System magnesowo-sensorowy CADIAX (“M“-Sensor) zawiera magnes w końcówce 
rylca. Z tego powodu należy zwrócić szczególną uwagę podczas stosowania go u 
pacjentów z rozrusznikami serca lub wszczepionymi defibrylatorami. Sprawdź 
koniecznie, czy na pewno zachowujesz bezpieczne odległości! W razie potrzeby 
skonsultuj się z kardiologiem. W razie wątpliwości przestań używać systemu CADIAX 
"M” Sensor. 

1.3 Przeznaczenie 

System CADIAX zaprojektowano do rejestracji i wyświetlania ruchów osiowych stawu żuchwowego u 
ludzi, konwersji tych ruchów na odległości międzykłykciowe artykulatora i obliczenia ustawień dla tego 
artykulatora, odpowiednio dla pacjenta. 

System jest używany przez dentystów i techników dentystycznych. 

1.4 O tej instrukcji obsługi 

Autorzy tego podręcznika zakładają, że czytelnik posiada podstawową wiedzę z zakresu obrazowania 
kłykci, pracy z łukiem twarzowym i przekazywaniem parametrów czaszki do artykulatora. 

Dodatkowo wymagana jest baza dźwiękowa w systemie operacyjnym Microsoft Windows. Użytkownik 
powinien być w stanie pracować z interfejsem użytkownika i z innymi elementami operacyjnymi 
programów Windows. 

Ten podręcznik nie zastępuje podstawowej edukacji w zakresie systemu operacyjnego Windows. Jeśli 
nie masz żadnego doświadczenia z zakresu systemów Windows, zalecamy, abyś najpierw się z nim 
zaznajomił. To bardzo ułatwi pracę z oprogramowaniem CADIAX. 

1.4.1 Symbole i powiadomienia 

Specjalną uwagę zwracamy na ważne aspekty zaznaczone następującymi symbolami: 

 
Uwaga Ten symbol wskazuje na możliwe źródło błędu lub ryzyko błędu operacyjnego. 

 
Info 

Tutaj znajdziesz szczególnie ważne informacje dodatkowe na opisywany 
temat. 

 
Wskazówka Użyteczne wskazówki i triki w pracy z systemem CADIAX. 

W niniejszym podręczniku do opisywania określonych komend i instrukcji będą używane następujące 
symbole i powiadomienia: 

• Nazwy klawiszy będą zapisywane pochyłym drukiem. Dla kombinacji klawiszy zostanie użyty znak 
plus (+), 
np.: CTRL+D oznacza: wciśnij i przytrzymaj klawisz CTRL, a następnie wciśnij klawisz D. 

• Pozycje menu oprogramowania CADIAX są zapisywane pochyłym drukiem. W wielu przypadkach 
pozycje menu należy wybierać kolejno; zostaną one połączone strzałkami,  
np.: File → Close oznacza: najpierw kliknij pozycję File z paska menu, a następnie kliknij pozycję 
otwartym menu: Close. 

 

Odwołania do „pasków” interfejsu użytkownika wyglądają następująco: 
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1 Pasek menu 

2 Pasek narzędzi 

3 Pasek zakładek 

4 Pasek stanu 

 

Ustawienia wyświetlania tych pasków i schematy kolorów aplikacji znajdziesz w menu View i 
Options. Poprzez wpis Customize Shortcut Keys w menu Options możesz przypisać kombinacje 
klawiszy użytkownika do poszczególnych funkcji. 

1.5 Zakres dostawy 

Dokładny zakres dostawy towarzyszy listowi przewozowemu. Kiedy otrzymasz system CADIAX, 
sprawdź zawartość przesyłki pod kątem kompletności i jakości dostawy. 

Materiał do mocowania uchwytu na zębach żuchwy pacjenta NIE jest zawarty w pakiecie dostawy. 

Do mocowania uchwytu zgryzowego niezbędny jest materiał rejestrujący zacisk zębów (np. Exabite II 
firmy GC) i odpowiedni dyspenser. 

Do mocowania uchwytu zgryzowego potrzebny jest kompozyt do tymczasowej odbudowy (np. Protemp 
II firmy 3M ESPE) i cement tymczasowy, taki jak cement na bazie tlenku cynku (np. TempBond firmy 
Kerr) lub karboksylowy (np. Durelon firmy 3M ESPE). 

 

W celu pozyskania dalszych informacji skontaktuj się z naszym dystrybutorem regionalnym. 

1.6 Wymogi dla systemu 

Do używania systemu CADIAX potrzebny jest komputer. Oprogramowanie GAMMA Dental Software w 
wersji 7.8 lub wyższej musi zostać zainstalowane na komputerze. To oprogramowanie nie wchodzi w 
zwykły zakres dostawy systemu CADIAX. 

 

Szczegóły wymagań sprzętowych komputera opisano w instrukcji oprogramowania GAMMA 
Dental Software. 
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Niezbędny jest również odpowiedni ekran do pracy przy fotelu dentystycznym. Zwróć uwagę, że 
odległość między użytkownikiem a ekranem może być większa niż wtedy, kiedy używa się zwykłych 
aplikacji komputerowych. 

Co więcej, do używania systemu CADIAX wymagany jest łuk twarzowy taki jak Condylograph Set, 
Condylograph comfort Set lub Condylograph comfort Set I. Te urządzenia nie wchodzą w podstawowy 
zakres dostawy systemu CADIAX. 
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2 Przygotowanie do używania urządzenia CADIAX 

Przed rozpoczęciem pracy z systemem CADIAX należy podjąć szereg kroków przygotowawczych. 

2.1 Instalacja oprogramowania 

 

Zainstaluj oprogramowanie przed pierwszym podłączeniem urządzenia CADIAX do komputera. 
Dzięki temu zainstalujesz niezbędne sterowniki pozwalające na rozpoznanie urządzenia. 

 

Szczegóły dotyczące instalacji oprogramowania opisano w instrukcji GAMMA Dental Software. 

2.2 Podstawowe ustawienia oprogramowania 

Po instalacji oprogramowania CADIAX należy dokonać kilku podstawowych ustawień. 

 

Podczas tej operacji urządzenie CADIAX nie musi być podłączone do komputera. 

2.2.1 Uruchamianie i aktywacja oprogramowania 

 

Procedurę uruchamiania i aktywacji oprogramowania opisano w instrukcji oprogramowania 
GAMMA Dental Software. 

Po zakończonej sukcesem aktywacji można uruchomić rejestrator CADIAX Recorder z GDSW classic 
lub GAMMA Document Browser; będzie on zapisywał zarejestrowane dane w odpowiednich bazach 
danych. 

 

2.2.2 Ustawienia łuku twarzowego 

Ustaw rodzaj używanego łuku twarzowego w menu Options → CADIAX Unit Settings: 
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Różne łuki twarzowe mają różne skale do wprowadzania geometrii twarzy. Po wybraniu 
niewłaściwego łuku twarzowego lub wprowadzeniu niewłaściwej wartości skali rejestracja nie 
zostanie prawidłowo przeliczona. To może doprowadzić do odkształcenia obrazu 
zarejestrowanego toru kłykciowego i w niektórych przypadkach, do zafałszowania ustawień 
parametrów dla artykulatora. 

Łuk twarzowy Condylograph comfort można używać z dowolnym z poniższych wskaźników punktów 
referencyjnych. 

Indywidualny wskaźnik punktu referencyjnego  Stałe wskaźniki punktów referencyjnych P 
(Pacjent) i T (Transfer). 

 

 

 

 

Stałe wskaźniki punktów referencyjnych są mocowane na wysokości 22 mm, której nie można 
regulować. Jeżeli sytuacja anatomiczna pacjenta wymaga innej wysokości, należy użyć 
indywidualnych wskaźników punktów referencyjnych. 

2.2.3 Test sprzętowy 

Zakładka Hardware Test oprogramowania CADIAX Recorder pozwala na sprawdzenie stanu sprzętu 
w systemie. 
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Wyświetlacz wskazuje błędy w systemie podświetlając uszkodzony komponent na grafice, 
a w obszarze Diagnostics wyświetla opis błędu. 
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3 Rejestracja toru ruchów stawów skroniowo-żuchwowych 

Co do zasady, rejestracja toru ruchów stawów s-ż przebiega zawsze w następujących krokach: 

1. Przygotowanie 

2. Mocowanie uchwytu na zębach żuchwy 

3. Zakładanie górnego łuku twarzowego: 

a. Condylograph 

b. Condylograph comfort 

4. Zakładanie łuku zapisującego 

5. Lokalizacja osi stawu 

6. Zakładanie płytek i rylców pomiarowych 

7. Rejestracja krzywych toru ruchów stawu 

8. Rejestracja CPM (jeżeli używany jest uchwyt para-okluzyjny). 

9. Kończenie rejestracji, zapisywanie danych. 

3.1 Ustawienie pacjenta 

Pacjent do badania powinien przyjąć wyprostowaną i rozluźnioną pozycję siedzącą. Ruchy ciała 
podczas rejestracji mogą zmieniać pozycję osi i należy ich unikać. Głowa powinna być wyprostowana 
w górę, a górna część kręgosłupa powinna się znajdować w normalnej pozycji (nie odchylać do przodu 
ani do tyłu). Zalecamy korzystanie ze wspornika głowy i szyi. 

Należy zdjąć okulary, kolczyki, klamry do włosów. Ładunek elektrostatyczny włosów może mieć wpływ 
na wynik zapisu. Efekt ten nasila obecność lakieru do włosów, dlatego lepiej, aby pacjenci wkładali 
czapeczki chirurgiczne. Długie włosy należy zaczesać do tyłu, za uszy. 

3.2 Instrukcje dla pacjenta 

Wyjaśnij pacjentowi, na czym polegają ruchy żuchwy takie jak protruzja, retruzja, mediotruzja i 
medioretruzja. Poproś pacjenta, aby wykonał wszystkie te ruchy w całości i tak daleko, jak to tylko 
możliwe. Przećwiczcie te ruchy przed założeniem łuku twarzowego. 

3.3 Przygotowania 

Przed rozpoczęciem rejestracji przygotuj wszystkie niezbędne urządzenia i materiały. 

Podłącz urządzenie CADIAX do komputera i uruchom oprogramowanie do rejestracji. Jeśli urządzenie 
zostało wykryte, zostanie to wskazane przez zmianę na pasku stanu oprogramowania. Jeśli tak się nie 
dzieje, sposób korekty tego błędu znajdziesz w rozdziale „Rozwiązywanie problemów”. 

3.3.1 Mocowanie uchwytu na zębach żuchwy 

Dostępne są dwa różne rodzaje uchwytów do mocowania łuku zapisującego do żuchwy: 

Zgryzowy uchwyt z łyżką wyciskową Zgryzowy uchwyt funkcjonalny (para-okluzyjny) 

  



CADIAX 4 

22 

U pacjentów bezzębnych uchwyt można założyć na żuchwę przy pomocy zacisku żuchwowego. 

 

Zgryzowy uchwyt z łyżką wyciskową i zgryzowy uchwyt funkcjonalny są dostarczane bez 
sterylizacji i należy je zdezynfekować i/lub wysterylizować przed użyciem. Instrukcje dotyczące 
czyszczenia i ponownego użycia znajdziesz w rozdziale „Czyszczenie”. 

 

Sprawdź stan periodontalny uzębienia żuchwy. Jeżeli stan ten jest niezadowalający, zrezygnuj 
z używania uchwytu lub - na odpowiedzialność lekarza dentysty - podejmij odpowiednie środki 
ostrożności (np. zszynowanie zębów) Obszary uzębienia obniżone z podcieniami lub 
szparowatością należy zawsze blokować odpowiednim materiałem (np. miękkim woskiem), 
nawet u pacjentów o dobrym stanie periodontalnym. 

Jeśli przymocujesz uchwyt do prowizorycznie zacementowanego uzębienia, pojawia się ryzyko, 
że uzębienie może się poluzować z uwagi na oddziaływania mechaniczne. W takich 
przypadkach musisz ustalić, czy cement tymczasowy jest do tego odpowiedni czy nie. 

 

Sprawdź czy zacisk na łuku zapisującym można łatwo wcisnąć na trzonek uchwytu. Jeżeli tak 
nie jest, nie używaj tego konkretnego uchwytu. 

3.3.1.1 Mocowanie zgryzowego uchwytu z łyżką wyciskową 

 

Jeżeli używasz zgryzowego uchwytu funkcjonalnego, możesz pominąć ten fragment. 

Zgryzowy uchwyt z łyżką wyciskową jest dostępny w wielu 
rozmiarach. Wybierz dla pacjenta uchwyt w odpowiednim 
rozmiarze. 

 

 

Przed wprowadzeniem materiału silikonowego wyłóż uchwyt 3 cienkimi wałeczkami miękkiego 
wosku (średnica 3-4 mm). Wałeczki są mocowane do łuku po przekątnych: jeden z przodu, a 
dwa z tyłu. W ten sposób wyznaczone zostają punkty załamania, które ułatwią zdejmowanie 
uchwytu. 

 

Używaj wyłącznie masy silikonowej (materiał rejestrujący zagryzanie) o twardości Shore’a 
maksymalnie A60. Postępuj zgodnie z instrukcjami producenta! 

Wypełnij uchwyt do maksymalnie 2/3 wysokości materiałem 
silikonowym. 

 

Umieść wypełniony uchwyt na zębach żuchwy i ustaw trzonek 
w środkowej pozycji strzałkowej. Pacjent wycofuje i zamyka 
żuchwę, automatycznie ustawiając trzonek w taki sposób, że 
uzyskuje się najmniejszy wymiar pionowy zgryzu przy oparciu 
zębów górnych o powierzchnię górną łyżki. 
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Przed zamocowaniem łuku zapisującego żuchwy należy całkowicie dopasować silikon, przy 
lekko otwartych ustach pacjenta. Postępuj zgodnie z instrukcjami producenta! Zaleca się 
pozostawienie oddzielnej próbki materiału poza ustami pacjenta, aby móc łatwo kontrolować 
proces tężenia. Sprawdź, czy w obszarach tylnych nie wystąpią żadne interferencje 
spowodowane wyciśnięciem materiału. 

3.3.1.2 Mocowanie zgryzowego uchwytu funkcjonalnego (para-okluzyjnego) 

 

Jeżeli używasz zgryzowego uchwytu z łyżką wyciskową, możesz pominąć ten fragment. 

Używanie uchwytu para-okluzyjnego pozwala na przeanalizowanie wpływu zgryzu na pozycję stawów 
skroniowo-żuchwowych i ruch osiowy stawu. Pomiary pozycji kłykciowej (CPM) można przeprowadzić 
bezpośrednio w ustach pacjenta, więc nie musisz już mierzyć CPM na zamontowanych modelach. 
Zgryzowy uchwyt funkcjonalny znajduje się poza kontaktami zgryzowymi zębów, więc nie dotyka zębów 
górnej szczęki ani w zaguzkowaniu, ani w funkcji. 

Do zamocowania zgryzowego uchwytu funkcjonalnego będzie 
Ci potrzebny kompozyt do odbudowy tymczasowej (np. 
Protemp II firmy 3M ESPE). 

 

Oprócz tego będzie Ci potrzebny cement tymczasowy: cement 
na bazie tlenku cynku (np. TempBond firmy Kerr) lub 
karboksylowy (np. Durelon firmy 3M ESPE). 

  

Umieść uchwyt w ustach pacjenta i zagnij skrzydełka, aby 
dopasować na dolnym łuku zębowym. Zostaw 1-2 mm 
przestrzeni między zębami a uchwytem. 

 

Umieść wcześniej uformowaną płytkę wosku na górnym łuku 
zębowym i poproś pacjenta, aby zagryzł. Płytka woskowa 
izoluje górne zęby przed niekontrolowanym wypływem 
kompozytu i eliminuje konieczność żmudnego czyszczenia. 

 

Przygotuj kompozyt zgodnie z instrukcjami producenta. 
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Pokryj uchwyt od strony powierzchni wargowych i 
policzkowych zębów warstwą kompozytu o grubości 2 mm. 
Odczekaj, aż materiał zacznie tężeć. 

 

Umieść uchwyt w ustach pacjenta i poinstruuj go, aby je 
zamknął tak, by górne zęby nie dotykały uchwytu (sprawdź to). 

Trzonek uchwytu powinien wypadać na środkowej 
płaszczyźnie strzałkowej. 

Poczekaj, aż materiał stężeje, a następnie usuń uchwyt z ust 
pacjenta. 

 

 

Usuń nadmiar kompozytu ostrym nożem lub frezem. 

 

 

Używaj jak najmniej kompozytu. Zbyt duża ilość często powoduje ból dziąseł. 

Sprawdź, czy uchwyt jest dobrze dopasowany w ustach. 
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Użyj kalki w celu odznaczenia powierzchni kontaktowych między kompozytem na uchwycie a 
zębami szczęki. Usuń nadmiar frezem. 

 

Jeśli kompozyt jeszcze nie stężał całkowicie, możesz odłożyć uchwyt na bok i zacząć mocować 
górny łuk twarzowy. 

Przygotuj cement zgodnie z instrukcjami producenta. 

Zamocuj uchwyt cementem na zębach żuchwy. 

 

 

Nie mocuj zgryzowego uchwytu funkcjonalnego na bolesnych albo luźnych zębach. 

Po rejestracji można łatwo zdjąć uchwyt. Zęby będą wymagały jedynie delikatnego czyszczenia 
(skalingu). U tego samego pacjenta pokryty kompozytem uchwyt może zostać użyty ponownie (nie 
trzeba koniecznie usuwać z niego pozostałości kompozytu). 

3.4 Mocowanie kinematycznego łuku twarzowego 

3.4.1 Condylograph 

3.4.1.1 Przygotowywanie górnego łuku twarzowego 

Przed zamocowaniem łuku Condylograph u pacjenta należy 
odciągnąć mocowania czołowe  

Delikatnie poluzuj śruby zaciskowe ramion bocznych, aby 
ramiona boczne mogły poruszyć się w kierunku strzałkowym 
(górna śruba) i poprzecznym (dolna śruba). 

Poluzuj i zdejmij wskaźnik punktu referencyjnego Orbitale. 

 

Górny łuk twarzowy jest teraz gotowy do założenia. 
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3.4.1.2 Zakładanie górnego łuku twarzowego 

Wyreguluj szerokość łuku twarzowego tak, aby ramiona boczne 
dotykały czaszki nad uszami, równo, bez napięcia. Łuk 
twarzowy powinien zostać ustawiony symetrycznie. 

 

Połóż łuk twarzowy na czole pacjenta, tak by wspornik nosowy 
spoczywał na punkcie Glabella, a ramiona boczne – nad 
uszami. 

 

Opuść wsporniki czołowe do momentu, aż dotkną skóry 
i unieruchom je. Należy uzyskać równe podparcie na czole i na 
punkcie Glabella. Stabilizuje to łuk twarzowy i znacząco 
poprawia komfort pacjenta. 

 

Taśmy utrzymujące należy ułożyć równolegle do ramion 
bocznych i zapiąć. Teraz łuk twarzowy powinien mocno 
trzymać się głowy bez dalszego przytrzymywania. 

 

Załóż czerwone płytki z etykietami do zapisu i umocuj je na łuku 
twarzowym. 
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Wyreguluj głębokość ramion bocznych, aby tylna krawędź 
płytki pokrywała skrawek ucha. 

 

 

Zwróć uwagę czy ramiona boczne znajdują się nad uszami. Łuk twarzowy nie może być 
odciągnięty przez taśmę utrzymującą – w dół, na małżowinę ani w górę. 

Zamocuj wskaźnik punktu referencyjnego Orbitale na 
poprzecznej belce łuku twarzowego i dotknij skóry 
wskaźnikiem. 

 

Aby wskazać pozycję punktu referencyjnego Orbitale przy 
pomocy znacznika ołowianego na zdjęciu RTG – możesz 
oznaczyć to miejsce na skórze. 

Następnie unieruchom wskaźnik punktu referencyjnego 
i zdejmij go z łuku twarzowego. 

 

3.4.2 Condylograph comfort 

3.4.2.1 Przygotowywanie górnego łuku twarzowego 

Delikatnie poluzuj śruby zaciskające ramion bocznych, aby 
mogły poruszyć się w kierunku strzałkowym (górna śruba 
zaciskająca) i poprzecznym (dolna śruba zaciskająca). 

Poluzuj i zdejmij wskaźnik punktu referencyjnego Orbitale. 

 

Zamocuj wspornik nosowy wsuwając go z boku do środka, aż 
do kliknięcia. 
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Miękki element wspornika nosowego można łatwo wymienić. 
Zakłada się ją na mostek nosowy. 

 

Górny łuk twarzowy jest teraz gotowy do założenia. 

3.4.2.2 Zakładanie górnego łuku twarzowego 

Wyreguluj szerokość łuku twarzowego tak, aby ramiona boczne 
dotykały czaszki nad uszami, równo, bez napięcia. Łuk 
twarzowy należy ustawić symetrycznie. 

 

Połóż łuk twarzowy na czole pacjenta, tak by wspornik nosowy 
spoczywał na gładziźnie (Glabella), a ramiona boczne – nad 
uszami. 

 

Taśmy utrzymujące należy ułożyć równolegle do ramion 
bocznych i zapiąć. Teraz łuk twarzowy powinien mocno 
trzymać się głowy bez dalszego przytrzymywania. 

 

Załóż czerwone płytki z etykietami do zapisu i umocuj je na łuku 
twarzowym. 
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Wyreguluj głębokość ramion bocznych, aby tylna krawędź 
płytki pokrywała skrawek ucha. 

 

 

Zwróć uwagę czy ramiona boczne znajdują się nad uszami. Łuk twarzowy nie może być 
odciągany przez taśmę utrzymującą – w dół, na małżowinę ani w górę. 

Zamocuj wskaźnik punktu referencyjnego Orbitale na 
poprzecznej belce łuku twarzowego i dotknij skóry 
wskaźnikiem. 

 

 

Aby wskazać pozycję punktu referencyjnego Orbitale przy 
pomocy znacznika ołowianego na zdjęciu RTG – możesz 
oznaczyć markerem to miejsce na skórze. 

Następnie unieruchom wskaźnik punktu referencyjnego 
i zdejmij go z łuku twarzowego. 

 

3.4.3 Przygotowanie żuchwowego łuku twarzowego 

Ustaw ramiona boczne żuchwowego łuku twarzowego w ich 
pozycji centralnej. 
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Delikatnie poluzuj śruby, aby ramiona boczne i podwójna śruba 
na wsporniku były ruchome. 

 

Wyreguluj dwie igły osiowe tak, aby wystawały 2 cm z obsadki. 

 

Żuchwowy łuk twarzowy jest teraz gotowy do założenia. 

3.4.4 Mocowanie żuchwowego łuku twarzowego 

Całkowicie rozsuń i unieruchom ramiona boczne łuku 
żuchwowego. Pacjent powinien mieć zamkniętą żuchwę w 
pozycji centralnej (dotylnej). Wsuń podwójny zacisk na uchwyt. 

Sprawdź, czy uchwyt się nie poluzował i ponownie sprawdź, 
czy jest on prawidłowo dopasowany. 

 

Wyreguluj żuchwowy łuk twarzowy, aby był równoległy 
w stosunku do górnego łuku twarzowego. 

Przykręć śrubę na ramieniu poprzecznym. W tym samym 
czasie podeprzyj żuchwowy łuk twarzowy drugą ręką, aby nie 
wywierać zbyt dużego nacisku na uchwyt. Silny nacisk może 
spowodować ból lub poluzowanie uchwytu. 

 

Wsuń igły osiowe do otworów na końcach ramion i ustaw je 
w pobliżu osi stawu. 

Na końcu zakręć śruby na końcach ramion bocznych dolnego 
łuku, aby unieruchomić ich pozycję w stosunku do ramienia 
poprzecznego. 

 



CADIAX 4 

31 

3.4.5 Wyznaczanie osi stawu (Hinge Axis) 

Wciśnij igły osiowe, aby dotknęły naklejek do zapisywania. 
Unieruchom igły w tej pozycji. 

 

Rozpocznij od wprowadzenia żuchwy do pozycji dotylnej stawu 
i lekko uciskając utrzymaj żuchwę w tej pozycji, poproś pacjenta 
o ruchy otwórz/zamknij w pozycji dotylnej, wyizoluj czysty ruch 
rotacyjny. 

 

Za pomocą śrub pozycjonujących ustaw pozycję ramion 
bocznych w taki sposób, aby igła osiowa wyłącznie się 
obracała, bez rysowania ruchu translacyjnego na płytce. 

 

3.4.6 Zakładanie sensorów 

 

Dotykaj płytek elektronicznych tylko na ich krawędziach. Unikaj dotykania czarnej powierzchni 
pomiarowej, aby nie dopuścić do zabrudzenia lub zarysowania. Sprawdź, czy tryb rejestracji 
jest wyłączony, kiedy zakładasz płytki i rylce. 

Załóż płytki elektroniczne w wyznaczonych do tego gniazdach 
w górnym łuku twarzowym. Nie pozwól, aby w tym czasie coś 
utknęło między ramionami bocznymi a płytkami. 

 

System podwójnego rylca pozwala na rejestrację obrotu osi 
stawu po obu stronach. 

Wsuń całkowicie rylec z większą obudową (grubsza srebrna 
obręcz) do otworu w ramieniu bocznym. Drugi rylec powinien 
być ustawiony nad pierwszym. Dokręć śrubę po górnej stronie 
ramienia bocznego, aby unieruchomić rylec. 

Jeśli system został prawidłowo zamocowany, a żuchwa jest 
w pozycji referencyjnej, końcówka rylca powinna znajdować 
się w obszarze górnej tylnej ćwiartki elektronicznej płytki.  
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Rylce powinny zostać ustawione w taki sposób, żeby ich osie wystawały nie więcej niż około 1 
cm na zewnątrz. Ten zakres ruchu jest wymagany, między innymi, do ruchów mediotruzyjnych. 

 

Unikaj dotykania powierzchni pomiarowych czarnych ekranów i rylców podczas procedur 
pomiarowych i prac przygotowawczych. Powinien tego unikać również pacjent. 

3.5 Ustawianie systemu CADIAX 

Podłącz złącze sterownika nożnego do odpowiedniego gniazda 
z boku urządzenia. 

 

Podłącz urządzenie do wolnego portu USB w swoim 
komputerze. 

 

Następnie podłącz sensory do urządzenia bazowego zgodnie 
z opisem na obudowie. 

 

3.6 Lokalizacja osi wspierana oprogramowaniem 

Oś stawu jest osią funkcjonalną, wokół której obraca się żuchwa podczas zamykania i otwierania ust. 
Żuchwa zamknięta w pozycji dotylnej jest pozycją referencyjną (RP) i punktem wyjścia dla lokalizacji 
osi stawu. 

Przed rozpoczęciem właściwej rejestracji, oprogramowanie do rejestracji pozwala na dokładne 
wyznaczenie pozycji osi stawu i odpowiednie ustawienie rylca. Do lokalizacji osi oprogramowanie 
wykorzystuje krzywe translacyjne, które rylce rysują na płytkach, kiedy nie są ustawione dokładnie w 
środku obrotu (czyli w osi stawu). 

Oprogramowanie umożliwia zastosowanie pojedynczej i dynamicznej metody lokalizacji osi. Ta druga 
metoda jest zalecana, ponieważ uśrednia wiele pomiarów, przez co lokalizacja osi stawu jest 
dokładniejsza. 

 

Jeśli wolisz wyznaczać pozycję osi stawu mechanicznie lub inną metodą, możesz opuścić tę 
funkcję lokalizacji osi i kontynuować ustawianie pozycji referencyjnej. 

 

Procedura lokalizacji osi może być powtarzana dowolną liczbę razy. Zawsze należy 
przeprowadzić ją przynajmniej raz jeszcze po wyregulowaniu pozycji rylca. 
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Prawidłowe zlokalizowanie osi stawu może być niemożliwe w przypadku poważnych dysfunkcji 
mięśniowych lub problemów stawu skroniowo-żuchwowego. W takich przypadkach 
dopuszczalna jest ręczna lokalizacja, taka jak podczas kondylografii mechanicznej. 

3.6.1 Lokalizacja osi pojedynczej 

Podczas lokalizacji osi pojedynczej system wykonuje dwa pomiary; jeden przy otwartych ustach 
pacjenta, a drugi – przy zamkniętych. Z tych dwóch pomiarów system jest w stanie wyliczyć punkt, 
wokół którego obracały się rylce, a tym samym – wyznaczyć lokalizację osi. 

 

1. Wyjaśnij procedurę pacjentowi. 

2. Poprowadź żuchwę pacjenta do pozycji referencyjnej. Spróbuj uniknąć kontaktu zębów, pozwoli 
to ustawić żuchwę w relacji stawowej bez interferencji zgryzowej. 

3. Wciśnij sterownik nożny, aby wykonać pomiar pierwszej pozycji. To uruchomi odliczanie 
końcowe dla pomiaru drugiej pozycji, wskazywane przez pasek postępu w oknie dialogowym. 

4. Poproś pacjenta, aby otworzył usta na około 15 mm. Upewnij się, czy żuchwa pozostaje w 
pozycji retralnej i nie wykonuje żadnych ruchów translacyjnych. Odczekaj, aż system wykona 
drugi pomiar. 

5. Pozwól pacjentowi wejść w pozycję referencyjną i kontynuować ustawianie rylców na 
wyznaczonej pozycji osi (zob. rozdz. „Ustawianie osi”). 

 

Często łatwiej pozwolić pacjentowi otworzyć usta do pierwszego pomiaru, a potem przejść do 
pozycji retralnej, centrycznej. Skoro ta pozycja jest również wykorzystywana do ustalania osi, 
można uniknąć dodatkowego źródła błędu. 

3.6.2 Lokalizacja osi dynamicznej 

W porównaniu z lokalizacją osi pojedynczej, lokalizacja osi dynamicznej wykorzystuje ciągłe ruchy 
otwierania/zamykania do wyznaczenia osi stawu. Wykonuje się tutaj wiele pomiarów i uśrednia dla 
uzyskania precyzyjniejszego rezultatu, nawet przy tylko niewielkich ruchach. 
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Jeśli w czasie lokalizacji osi wyświetli się symbol "Rotate Stylus" („Obróć Rylec”), będzie to 
oznaczało, że rylec znajduje się w niewłaściwej pozycji w odniesieniu do osi obrotu żuchwy. 
Możesz to rozwiązać obracając odpowiedni rylec w uchwycie. 

 

Jeżeli podczas lokalizacji osi pojawi się symbol "No Contact" („Brak kontaktu”), oznacza to, 
że rylec utracił kontakt z powierzchnią płytki. Jeśli wszystkie kable są prawidłowo 
podłączone, a rylec znajduje się we właściwym obszarze płytki, przyjrzyj się powierzchni 
płytki i w razie potrzeby ją wyczyść. 

 

 

1. Wyjaśnij procedurę pacjentowi. 

2. Poprowadź żuchwę pacjenta do pozycji referencyjnej. Spróbuj uniknąć kontaktu zębów, abyś 
mógł ustawić żuchwę w relacji stawowej bez interferencji zgryzowej. 

3. Wciśnij przełącznik nożny, aby rozpocząć pomiar. 

4. Przeprowadź żuchwę pacjenta przez powtarzane ruchy otwierania i zamykania. Sprawdź, czy 
żuchwa pozostaje w pozycji retralnej i nie wykonuje żadnych ruchów translacyjnych. 
Oprogramowanie w czasie rzeczywistym będzie wyświetlać obliczone punkty osiowe i liczbę 
wykonanych pomiarów. 
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5. Po wykonaniu wystarczającej liczby pomiarów, oprogramowanie poinformuje o tym 
wyświetlając na zielono obliczony punkt osiowy po obu stronach. Wówczas możesz ponownie 
wcisnąć przełącznik nożny w celu zatrzymania pomiarów. 

 

 

6. Pozwól pacjentowi wejść w pozycję referencyjną i kontynuuj ustawianie rylców do 
wyznaczonej pozycji osi (zob. rozdz. „Ustawianie osi”). 

 

Kolor obliczonego punktu osiowego informuje o liczbie poszczególnych pomiarów. Przy liczbie 
do pięciu pomiarów będzie to kolor czerwony, do dziesięciu – niebieski, a powyżej dziesięciu – 
zielony. 
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Zaawansowane opcje obliczeń punktów osiowych znajdziesz w menu Options → Axis 
Location Parameters. 

3.6.3 Ustawianie osi 

Po zlokalizowaniu punktów osiowych rylce muszą zostać ustawione w tych pozycjach. Podczas 
ustawiania osi obliczone punkty osiowe wyświetlają się jako białe okręgi, a faktyczne pozycje rylców 
jako czerwone krzyżyki. 

 

1. Sprawdź, czy pacjent znajduje się w pozycji referencyjnej i pozostaje w niej podczas ustawiania 
osi. 

2. Wyreguluj nachylenie i długość ramion bocznych 
dolnego łuku, aby czerwone krzyżyki pozostały w 
ramach białych okręgów. 

 

3. Jak tylko rylce zostaną ustawione wystarczająco blisko punktów osiowych, możesz wcisnąć 
sterownik nożny, aby kontynuować ustawianie punktów referencyjnych i wprowadzanie 
paramentów łuku twarzowego. 

 

Podczas ustawiania osi odległość między pozycją rylca a punktem osiowym wyświetla się (w 
milimetrach) przy dolnej krawędzi okna. Kiedy tylko odległość ta spadnie poniżej określonego 
progu, widok powiększy się automatycznie, co pozwoli na dokładniejsze dopasowanie. 

 

Aby zweryfikować powtarzalność twojej metody lub pozycję stawów, możesz powtórzyć 
lokalizację osi, a potem ustawienia osi dowolną liczbę razy. 

 

Możesz oznaczyć pozycje, pokazać tory ruchu i zmienić ustawienia powiększenia poprzez 
menu View. 
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3.7 Ustawianie pozycji referencyjnej 

Poprowadź pacjenta do dotylnej pozycji referencyjnej i wciśnij sterownik nożny. Ustawiona tutaj 
pozycja będzie służyła za punkt zerowy dla dalszych rejestracji. 

 

 

Możesz zresetować pozycję referencyjną między rejestracjami poprzez funkcję „refix” lub 
przechodząc do tej zakładki. 

3.8 Wprowadzanie parametrów łuku twarzowego 

Aby przeliczyć rejestracje zgodnie z mocowaniem górnego łuku twarzowego należy wprowadzić 
parametry łuku twarzowego. 

 

Szczegółowe instrukcje dotyczące wyboru wykorzystywanego łuku twarzowego opisano w 
rozdziale „Ustawianie łuku twarzowego”. 

 

Zwróć uwagę, że terminy „lewy” i „prawy” zawsze odnoszą się do strony ciała pacjenta. 
Wszystkie wartości należy wprowadzać w milimetrach. 

3.8.1 Condylograph 

Korzystając z łuku twarzowego Condylograph należy wprowadzić następujące parametry. 
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Y-Shift – Przesunięcie Y – jest przesunięciem dowolnego boku ramienia górnego łuku twarzowego 
w lewo lub w prawo. Można je odczytać ze skali z przodu poprzecznego ramienia łuku twarzowego. 
Wartości zlokalizowane w kierunku wewnętrznym względem punktu zero na skali wprowadza się jako 
wartości ujemne. 

X-Shift – Przesunięcie X – jest przesunięciem dowolnej strony ramienia górnego łuku do tyłu lub do 
przodu. Można je odczytać ze skali na ramieniu bocznym. Wartości zlokalizowane z tyłu względem 
punktu zero na skali wprowadza się jako wartości ujemne. 

anterior face bow height (Wysokość przednia łuku twarzowego) to różnica wysokości między 
zaznaczonym punktem orbitalnym a górnym łukiem twarzowym. Wartość tę można odczytać ze skali 
pionowej wskaźnika punktu referencyjnego. 

anterior face bow depth (Głębokość przednia łuku twarzowego) to różnica głębokości między 
zaznaczonym punktem orbitalnym na skórze a górnym łukiem twarzowym. Wartość tę można 
odczytać ze skali poziomej wskaźnika punktu referencyjnego. 

3.8.2 Condylograph comfort 

Korzystając z łuku twarzowego Condylograph comfort należy wprowadzić następujące parametry. 
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Y-Shift – Przesunięcie Y – jest przesunięciem dowolnego boku ramienia górnego łuku twarzowego 
w lewo lub w prawo. Można je odczytać ze skali na poprzeczce łuku twarzowego. 

X-Shift – Przesunięcie X – jest przesunięciem dowolnej strony ramienia górnego łuku do tyłu lub do 
przodu. Można je odczytać ze skali na ramieniu bocznym. 

Aanterior face bow height (Wysokość przednia łuku twarzowego) to różnica wysokości między 
zaznaczonym punktem orbitalnym a górnym łukiem twarzowym. Wartość tę można odczytać ze skali 
pionowej wskaźnika punktu referencyjnego. 

Kiedy używasz nieruchomych wskaźników punktów referencyjnych, wartości nie można zmienić, jest 
ona stała na wysokości mocowania równa 22 mm. 

Anterior face bow depth (Głębokość przednia łuku twarzowego) to różnica głębokości między 
zaznaczonym punktem orbitalnym na skórze a górnym łukiem twarzowym. Wartość tę można 
odczytać ze skali poziomej wskaźnika punktu referencyjnego. 

Kiedy używasz indywidualnego wskaźnika punktu referencyjnego, należy również określić pozycję, w 
której wartość jest mierzona. W pozycji T (transfer) wskaźnik jest ułożony równolegle do ramion 
bocznych łuku twarzowego, a w pozycji P (pacjent) – jest nachylony pod kątem 30 stopni w kierunku 
nosa pacjenta. 

3.9 Rejestracja ruchów stawu 

3.9.1 Krzywe toru stawu 

Po ustawieniu pozycji referencyjnej i wprowadzeniu parametrów łuku twarzowego można rozpocząć 
właściwą rejestrację krzywych kondylografii. Aby to zrobić, przejdź do zakładki Recording. 
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Jeśli często używasz tej samej sekwencji rejestracji, możesz utworzyć do tego makro. 
Szczegóły opisano w rozdziale „Korzystanie z makr rejestracji”. 

Rejestrator CADIAX Recorder pozwala na wykonanie nieograniczonej liczby rejestracji. Aby 
zarejestrować nową krzywą wybierz New Curve w menu Data lub odpowiedni klawisz na pasku 
narzędzi. Na ekranie wyświetli się okno dialogowe dla określenia parametrów rejestracji. 

 

Type w tym oknie dialogowym odnosi się do nazwy krzywej, która zostanie przekazana do aplikacji 
analizujących i pozostanie w nich edytowalna. 

Time określa, jak długo będą rejestrowane ruchy pacjenta. Do tego celu uzasadniony jest okres 4,5 
sekundy. Dla ruchów trwających dłużej (żucie, mówienie, itp.) można odpowiednio zwiększyć ten 
okres. 

 

Zanim rozpoczniesz rejestrację, sprawdź, czy pacjent znajduje się w pozycji referencyjnej. W 
idealnym przypadku czerwony krzyżyk kursora w czasie rzeczywistym jest ustawiony 
dokładnie na początku układu współrzędnych. Jeżeli ta pozycja jest trudna do powtórzenia, 
można ponownie ustawić pozycję referencyjną oprogramowania klawiszem o tej samej nazwie 
(zob. rozdział „Ustawianie pozycji referencyjnej”). 

 

Typy rejestracji, zarówno systemowe, jak i użytkownika można skonfigurować w menu Edit → 
Definitions. Zamiast wybierać dostępny rodzaj możesz również dla rejestracji wprowadzić 
nazwę użytkownika. 
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Po potwierdzeniu parametrów rejestracji kliknięciem OK 
można rozpocząć rejestrację wciskając sterownik nożny. 
Następnie pacjent powinien wykonać wybrane ruchy. 

 

Rozpoczęcie i zakończenie rejestracji są sygnalizowane akustycznie. Podczas rejestracji jej postęp 
będzie widoczny na pasku w czasie rzeczywistym, tak jak będzie się wyświetlał rysunek krzywej. 

 
 

Po zakończeniu rejestracji wyświetli się ona w oknie rejestracji; można wówczas przejść do kolejnej. 

 

Aby usunąć wykonaną rejestracji możesz użyć pozycji menu Data → Delete lub klawisza z paska 
narzędzi. 

 

Sprawdź jakość krzywej natychmiast po rejestracji. Aby to zrobić, sprawdź punkt początkowy 
toru ruchu w odniesieniu do pozycji referencyjnej (czyli początku układu współrzędnych) oraz 
płynność linii krzywej. W idealnym przypadku ruch rozpocznie się dokładnie w punkcie 
zerowym i nie będzie wykazywać żadnych zniekształceń. 

Rejestracje z wyraźnymi zakłóceniami powinny zostać odrzucone. W takim przypadku 
całkowicie wyczyść płytki i rylce i powtórz rejestrację. Jeśli to nie wyeliminowało zakłóceń, 
anuluj rejestrację i skontaktuj się z autoryzowanym serwisem firmy GAMMA. 
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Oprócz tego tory ruchów, które znacząco różnią się od oczekiwanych kształtów należy 
traktować sceptycznie i zweryfikować je dalszymi rejestracjami. 

 

Zwróć uwagę, że ruchy mediotruzja prawa i mediotruzja lewa zawsze odnoszą się do kłykcia 
pacjenta wykonującego ruch mediotruzyjny. Mediotruzja prawa oznacza ruch żuchwowy (czyli 
ruch brody) w stronę lewą (i odwrotnie). 

 

Aby nałożyć jedną krzywą na drugą możesz ustawić wcześniej wykonaną krzywą aby 
wyświetlała się w tle korzystając z menu Data → Selected As Reference Curve, odpowiedniego 
klawisza z paska narzędzi lub klikając dwukrotnie pozycję na liście. 

3.9.2 Pomiar pozycji kłykcia (CPM) 

Pomiar pozycji kłykcia (CPM) opisuje pomiar przesunięcia 3D w stawie między pozycją referencyjną a 
każdą inną pozycją stawu (np. maksymalne zaguzkowanie ICP). W przypadku CPM pierwszy pomiar 
rejestracji będzie odniesieniem dla kolejnych. 

 

Naturalnie pomiary pozycji względem okluzji (np. ICP) mają sens tylko wtedy, kiedy uchwyt 
mocujący do zębów jest unieruchomiony na zębach żuchwy w pozycji nie przeszkadzających 
maksymalnemu zagryzieniu (łyżka para-okluzyjna). 

Aby zarejestrować nową krzywą wybierz New CPM w menu Data lub odpowiedni klawisz na pasku 
narzędzi. Na ekranie wyświetli się okno dialogowe dla określenia parametrów rejestracji CPM. 

 

Podobnie jak w przypadku parametrów rejestracji – Type jest nazwą przypisaną do CPM. Rejestracja 
typu Point Mode może zawierać nieograniczoną liczbę indywidualnych pomiarów, które są 
wykonywane kolejnymi przyciśnięciami przełącznika nożnego. 

W przypadku CPM – Time odnosi się do czasu między pierwszym a drugim pomiarem. Impulse 
oznacza nieokreślony czas, po którego upływie drugi pomiar można wykonać natychmiast po kolejnym 
wciśnięciu przełącznika nożnego. 

 

Rodzaje rejestracji systemowe i użytkownika można skonfigurować w menu Edit → Definitions. 
Zamiast wybierać dostępny rodzaj można również wprowadzić nazwę użytkownika dla 
rejestracji. 

Predefiniowane akronimy oznaczają:  
RP: Pozycja referencyjna  

RCP: Retralna pozycja kontaktowa 

ICP:  Maksymalne zaguzkowanie 

RES: Elastyczność stawu żuchwowego 

ETP: Oczekiwana pozycja terapeutyczna 

IVP: Idealna pozycja wertykalna 

FBP: Maksymalne zaguzkowanie z użyciem siły zgryzowej 

Po potwierdzeniu parametrów rejestracji kliknięciem OK można rozpocząć rejestrację wciskając 
przełącznik nożny. 
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Rozpoczęcie i zakończenie rejestracji jest sygnalizowane akustycznie. Jeśli czas pomiędzy dwoma 
pomiarami został określony, postęp rejestracji będzie się wyświetlać na pasku. 

 

Po zakończeniu rejestracji wyświetli się ona w oknie rejestracji; można wówczas przejść do kolejnej. 

 

W celu usunięcia wykonanej rejestracji można użyć pozycji menu Data → Delete lub klawisza z 
paska narzędzi. 

Wybierając punkty CPM na układzie współrzędnych można wyświetlić następujące wartości przy 
dolnej krawędzi okna: 

Delta X odległość między dwoma pomiarami wzdłuż osi X, czyli w kierunku strzałkowym (+X = 
przednia, -X = tylna), dla strony lewej i prawej. 

Delta Y odległość między dwoma pomiarami wzdłuż osi Y, czyli w kierunku poprzecznym (+Y = w 
prawo, -Y = w lewo). 

Delta Z odległość między dwoma pomiarami wzdłuż osi Z, czyli w kierunku pionowym (+Z = w 
dół, -Z = w górę), dla strony lewej i prawej. 

Delta H Różnica w wysokości pinu siecznego w artykulatorze. 
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Delta W Przesunięcie boczne pinu siecznego na stoliku siecznym  

Delta L Przesunięcie tylno-przednie pinu siecznego na stoliku siecznym  

Gamma Wielkość obrotu osi stawu między dwoma pomiarami. 

3.9.3 Korzystanie z makr rejestracji 

Podczas rejestracji makr można jednorazowo zdefiniować wykorzystywane wielokrotnie sekwencje 
krzywych i rejestracji CPM i powtarzać je podczas kolejnych sesji rejestracji. 

Edytor makr pozwala tworzyć nowe makra lub edytować istniejące. Żeby tego dokonać wybierz Edit 
Macro File w menu Data. 

 

Użyj dostępnych klawiszy, aby dodać krzywą lub rejestrację CPM do sekwencji lub usunąć je. Możesz 
zmienić kolejność pozycji na liście przeciągając je przy wciśniętym lewym klawiszu myszki. Po 
zakończeniu zapisz makro do pliku używając do tego odpowiedniego klawisza. 

Aby użyć utworzonego makra podczas rejestracji, wejdź w zakładkę Recording i wybierz menu Data 
→ CADIAX® Recorder Macro lub odpowiedni klawisz na pasku narzędzi. 

 

Opcja Macro Easy Start w menu Options pozwala na rozpoczęcie indywidualnych rejestracji 
jednym wciśnięciem przełącznika nożnego podczas wykonywania makra rejestracji. 

3.10 Zakończenie rejestracji 

Po wykonaniu wszystkich rejestracji możesz przenieść je do oprogramowania GAMMA Dental 
Software przez menu Data → Save All lub przez ikonę dyskietki na pasku narzędzi. 

 

Aby nie doszło do utraty danych spowodowanej problemami pojawiającymi się podczas 
zapisywania rejestracji, dane będą zapisywane w podkatalogu GDSW/Temp w bieżącym 
folderze dokumentów użytkownika. Aby odzyskać taki plik z rozszerzeniem *.cxc, użyj 
odpowiedniej pozycji z menu Data. 

 

Kiedy zaczynasz demontować system, sprawdź najpierw, czy tryb rejestracji został wyłączony! 

Demontuj system w odwrotnej kolejności. Najpierw poluzuj rylec i płytki pomiarowe z łuku 
twarzowego, a następnie zdejmij żuchwowy łuk twarzowy z uchwytu. Później zdejmij górny łuk 
twarzowy, a na końcu zdejmij uchwyt. 

 

Aby poluzować uchwyt, przesuń ostrożnie jego trzpień w górę i w dół. Podczas zdejmowania 
uchwytu zwróć uwagę, aby przypadkowym ruchem nie uderzyć nim o zęby szczęki. Jeśli to 
konieczne – osłoń je, np. płytką woskową umieszczoną między zębami. 
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3.11 Wyświetlanie w czasie rzeczywistym 

Rejestrator CADIAX Recorder oferuje kilka sposobów wizualizacji ruchów rylca na płytkach 
pomiarowych w czasie rzeczywistym bez wykonywania rejestracji. 

3.11.1 Płytki 

Zakładka Flags wyświetla fizyczne położenie X/Z końcówek rylca na płytkach pomiarowych. 

 

 

Możesz oznaczyć pozycje, pokazać tory ruchu i zmienić ustawienia powiększenia poprzez 
menu View. 

3.11.2 Dane liniowe i AUX 

Zakładka Linear and AUX data wyświetla zmierzone współrzędne i wartości AUX w czasie. Górny 
obszar wyświetlania przedstawia prawą stronę pacjenta, a dolny – lewą. 
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Możesz wyregulować prędkość wyświetlania i to, aby krzywe wyświetlały się przez obszar przy 
prawej krawędzi okna. 

 

Dane AUX z zewnętrznych źródeł mogą być przetwarzane tylko na urządzeniach 
diagnostycznych CADIAX. 

3.11.3 Animacja 

Zakładka 3D Animation wizualizuje zmierzone ruchy żuchwy przy pomocy wirtualnej prezentacji 
żuchwy pacjenta. 
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Obszar po lewej stronie okna pozwala na wybór rozmaitych opcji wyświetlania. 
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4 Dodatkowe informacje 

System CADIAX jest indywidualnym systemem rejestracji, w którym ruchy stawu żuchwowego 
rejestrowane są dokładnie na pozycji osi stawu pacjenta. Inaczej działa arbitralny (narzucający 
pozycję) system rejestracji, wykorzystujący statystyczną pozycję osi stawu, która może choć nie musi 
być bliska faktycznej osi pacjenta. Jednak w obu przypadkach wykorzystywana jest metoda pomiaru 
zbliżona do stawu. 

Zaletą pomiarów arbitralnych jest łatwość ustawienia rylców pomiarowych na predefiniowanym 
anatomicznym punkcie osiowym stawu. Ten punkt jest definiowany w odniesieniu do kanału usznego 
przez system mechaniczny i można go łatwo regulować. Skoro jednak ten punkt może różnić się od 
rzeczywistej osi stawu pacjenta, również ruchy żuchwy w stawie s-ż używane do programowania 
artykulatora (protruzja i mediotruzja) mogą mieć zniekształconą charakterystykę krzywej. 

4.1 Referencyjny układ współrzędnych 

Dla rejestracji powtarzalnych ruchów stawów skroniowo-żuchwowych wprowadzono referencyjny 
układ współrzędnych, który umożliwia przeprowadzenie znormalizowanej konwersji w artykulatorze. 
Ten układ współrzędnych jest określony jako układ współrzędnych „oś stawu-Orbital”. 

Początek układu współrzędnych leży pośrodku 
między kłykciami, w punkcie, w którym oś stawu 
w pozycji zero (referencyjnej) przecina się ze 
środkową płaszczyzną strzałkową. Z tego 
początku układu współrzędnych dodatnia oś X 
biegnie do przodu w kierunku punktu orbitalnego, 
dodatnia oś Z w dół, a dodatnia oś Y biegnie w 
prawo (z punktu widzenia pacjenta). 

 

 

Górny wykres obrazuje ruch Benneta lub ruch 
poprzeczny powiązanego kłykcia (na grafice: oś 
X jest ułożona poziomo, a oś Y - pionowo). 
Poniższy wykres ilustruje płaszczyznę 
strzałkową, podzieloną na punkty rozłożone w 
odległości 1 milimetra, gdzie oś X jest ułożona 
poziomo, a oś Z – pionowo. 

Początkiem wszystkich układów graficznych jest 
pozycja referencyjna, którą wyznacza się przez 
odpowiednią funkcję Reference Point. Punkty 
początkowe krzywych nie muszą zawsze być 
zgodne z początkiem układu współrzędnych. 

Powyższe przekroje obydwu układów 
współrzędnych Bennetta są ułożone dośrodkowo 
(dodatni ruch Bennetta, zgodnie z poprzednim 
standardem) i opisują przesunięcie poprzeczne 
osi stawu. Strzałkowe układy współrzędnych są 
ustawione do przodu i wskazują na środek grafiki. 

 

Układ współrzędnych z projekcją strzałkową i poprzeczną 

 

Rozszerzony układ współrzędnych z projekcją strzałkową i 
przednią 
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Widok można przełączać na rozszerzony układ współrzędnych przez menu View. Nazwy 
i kierunki osi można przystosować poprzez wpis Coordinate System w menu Options. 

4.2 Montaż w artykulatorze 

System CADIAX wykorzystuje płaszczyznę osiowo-orbitalną (AOP Axis-Orbital Plane) jako 
płaszczyznę referencyjną do rejestracji i transferowania pozycji szczęki do artykulatora (zob. rozdz. 
„Referencyjny układ współrzędnych”). W artykulatorze płaszczyzna jest opisywana przez prawy i lewy 
punkt osiowy stawu i płaszczyznę kontaktową stolika siecznego. 

 

Dzięki temu, kiedy model szczęki jest przenoszony do artykulatora przy pomocy łuku twarzowego, 
obliczone wartości będą pasować do rzeczywistych ustawień obudowy kłykciowej artykulatora. Do 
przenoszenia pozycji modelu służy widelec zgryzowy mocowany do łuku twarzowego przy pomocy w 
pełni uwalnianego łącznika 3D. Pobieramy wycisk szczęki i po odlaniu rejestrujemy model w zestawie 
do przenoszenia lub bezpośrednio w artykulatorze. 

  

Jeżeli do przenoszenia wykorzystany jest inny łuk twarzowy, należy sprawdzić, czy jest on ustawiony 
względem tych samych punktów referencyjnych. Tylko wówczas można zagwarantować, że wartości 
obliczone przez system CADIAX będą pasowały do modelu w artykulatorze. 

Szczegółowe informacje na temat przenoszenia łukiem twarzowym i montowania modeli w 
artykulatorze opisano w instrukcji obsługi "Artykulator referencyjny SL i systemy łuków twarzowych”. 

4.3 Próg ISS 

Próg ISS (ISS - TH) dzieli mierzoną krzywą na dwie części (zob. grafikę). Część początkowa jest 
niezbędna dla obliczenia ISS Immediate Side-Shift (natychmiastowe przesunięcie boczne), druga 
sekcja – do obliczenia PSS Progressive Side-Shift (progresywne przesunięcie boczne) lub TCI 
Transversal Condylar Inclination (poprzeczne nachylenie kłykcia). 
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5 Rozwiązywanie problemów 

Korygowanie błędów w systemie CADIAX zawsze wiąże się z dwoma krokami: po pierwsze – 
zidentyfikowaniem problemu, a następnie przeprowadzeniem zalecanego rozwiązania w celu 
wyeliminowania błędu. 

Jeśli pojawią się błędy, które nie zostały opisane w tym rozdziale, w celu rozwiązania problemu 
skontaktuj się z autoryzowanym serwisem firmy GAMMA. 

Urządzenie nie jest wykrywane przez oprogramowanie rejestrujące i nie pali się zielona kontrolka z 
przodu urządzenia. 

Możliwa przyczyna błędu Rozwiązanie 

Urządzenie nie jest podłączone do komputera. Podłącz urządzenie przez port USB w twoim 
komputerze. 

Awaria połączenia USB między urządzeniem a 
komputerem. 

Użyj innego portu USB lub innego kabla USB. 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Urządzenie nie jest wykrywane przez oprogramowanie rejestrujące, ale pali się zielona kontrolka z 
przodu urządzenia. 

Możliwa przyczyna błędu Rozwiązanie 

Awaria połączenia USB między urządzeniem a 
komputerem. 

Użyj innego portu USB lub innego kabla USB. 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Sterownik oprogramowania nie został poprawnie 
zainstalowany lub nie jest wcale zainstalowany. 

Odłącz urządzenie CADIAX od komputera. 
Uruchom instalatora oprogramowania i wykonaj 
procedurę naprawy.  Zrestartuj komputer i podłącz 
na nowo urządzenie po krótkim oczekiwaniu. 
Uruchom oprogramowanie rejestrujące dopiero 
kiedy system operacyjny zakończy konfigurację 
urządzenia. 

Jeśli komputer jest podłączony do Internetu, 
możesz również zainstalować sterowniki 
automatycznie przez Windows Update. 

Inne problemy związane z oprogramowaniem. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Zielona kontrolka z przodu urządzenia miga powoli i/lub oprogramowanie rejestrujące powiadamia, że 
wystąpił błąd sprzętowy. 

Możliwa przyczyna błędu Rozwiązanie 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Po zamocowaniu pozycja rylców wypada poza powierzchniami pomiarowymi płytek. 

Możliwa przyczyna błędu Rozwiązanie 

Żuchwa pacjenta nie znajdowała się w pozycji 
referencyjnej w momencie ustawiania łuku 
zapisującego do punktu osiowego stawu. 

Powtórz procedurę dopasowania łuku 
zapisującego. Sprawdź, czy pacjent trzyma 
żuchwę zamkniętą w pozycji centralnej. 

Śruby zaciskające utrzymujące łuk zapisujący nie 
są dokładnie zaciśnięte. 

Sprawdź, czy śruby zaciskające utrzymujące łuk 
są mocno dokręcone na trzpieniu uchwytu i na 
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ramionach bocznych. W przeciwnym razie 
dodatkowa siła wywołana przez zamocowane 
rylce może spowodować dalsze przemieszczenia. 

Po założeniu system wskazuje na brak kontaktu między rylcem a płytką po jednej stronie. 

Możliwa przyczyna błędu Rozwiązanie 

Rylec nie jest podłączony. Podłącz rylec do urządzenia CADIAX. 

Płytka nie jest podłączona. Podłącz płytkę do urządzenia CADIAX. 

Lewy i prawy sensor pomiarowy zostały 
zamienione. 

Załóż wtyki poprawnie. 

Rylec znajduje się poza dozwolonym obszarem 
pomiarowym płytki z powodu niewłaściwego 
zamocowania. 

Załóż ponownie górny łuk twarzowy. Sprawdź, czy 
oba rylce są ustawione w taki sposób, aby 
pozostawały na czarnej powierzchni pomiarowej 
płytki, również podczas ruchów mediotruzyjnych. 

płytka pomiarowa jest zanieczyszczona. Z powodu zabrudzenia płytki brak jest ciągłego 
kontaktu elektrycznego między końcówką rylca a 
powierzchnią pomiarową płytki. Wyczyść 
powierzchnię płytki zgodnie z dołączoną instrukcją 
czyszczenia. 

rylec jest uszkodzony. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

płytka jest uszkodzona. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Zarejestrowane krzywe idą „wstecz” zamiast protruzyjnie. 

Możliwa przyczyna błędu Rozwiązanie 

Lewy i prawy sensor pomiarowy zostały 
zamienione. 

Załóż wtyki poprawnie. 

Zarejestrowane krzywe nie zaczynają się w początku układu współrzędnych. 

Możliwa przyczyna błędu Rozwiązanie 

Pozycja rylców zmieniła się między ustawieniem 
pozycji referencyjnej a rozpoczęciem rejestracji. 

Powtórz ustawianie pozycji referencyjnej. Jeśli to 
konieczne, powtarzaj tę procedurę przed każdą 
rejestracją. 

Zarejestrowane krzywe wykazują zakłócenia. 

Możliwa przyczyna błędu Rozwiązanie 

płytka pomiarowa jest zanieczyszczona. Ze względu na zabrudzenia płytki brak jest 
ciągłego kontaktu elektrycznego między końcówką 
rylca a powierzchnią pomiarową płytki. Wyczyść 
powierzchnię płytki zgodnie z dołączoną instrukcją 
czyszczenia. 

Rylec znajduje się poza dozwolonym obszarem 
pomiarowym płytki z powodu niewłaściwego 
zamocowania. 

Załóż ponownie górny łuk twarzowy. Sprawdź, czy 
oba rylce są ustawione w taki sposób, aby 
pozostawały na czarnej powierzchni pomiarowej 
płytki, również podczas ruchów mediotruzyjnych. 

 „Efekt przesuwania krzesła” na skutek tarcia 
powierzchni między płytką, a rylcem. 

Ruch rylca po powierzchni płytki może 
spowodować tzw. „efekt przesuwania krzesła”. 
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Wówczas końcówka rylca na krótko podnosi się z 
powierzchni płytki powodując utratę kontaktu 
elektrycznego. Efektowi temu często towarzyszy 
skrzypiący dźwięk podczas ruchu. 

Aby zminimalizować ten efekt, nałóż na 
powierzchnię płytki odrobinę wazeliny. Koniecznie 
wyczyść płytkę po rejestracji. 

Rylec jest uszkodzony. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Płytka jest uszkodzona. 

 

Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Zarejestrowane krzywe są zbyt krótkie po jednej stronie. 

Możliwa przyczyna błędu Rozwiązanie 

Płytka pomiarowa jest zanieczyszczona. Ze względu na zabrudzenia płytki brak jest 
ciągłego kontaktu elektrycznego między końcówką 
rylca a powierzchnią pomiarową płytki. Wyczyść 
powierzchnię płytki zgodnie z dołączoną instrukcją 
czyszczenia. 

Rylec znajduje się poza dozwolonym obszarem 
pomiarowym płytki z powodu niewłaściwego 
zamocowania. 

Załóż ponownie górny łuk twarzowy. Sprawdź, czy 
oba rylce są ustawione w taki sposób, aby 
pozostawały na czarnej powierzchni pomiarowej 
płytki, również podczas ruchów mediotruzyjnych. 

Prawy lub lewy sensor pomiarowy nie jest 
podłączony do urządzenia. 

Załóż wtyczki poprawnie. 

Rylec jest uszkodzony. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Płytka jest uszkodzona. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 

Urządzenie CADIAX jest uszkodzone. Skontaktuj się z autoryzowanym serwisem firmy 
GAMMA. 
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6 Specyfikacja 

6.1 Dane techniczne 

Rozdzielczość ADC: 16 bit 

Wyświetlanie danych 
pomiarów: 

0,01 mm 

Dokładność pomiaru 
odległości: 

± 5 % 

Dokładność pomiaru kąta: ± 1,5 ° 

Napięcie: 5 V DC (zgodnie ze specyfikacją USB) 

Prąd na wejściu: maks. 0,5 A (zgodnie ze specyfikacją USB) 

Klasa ochronności: B 

 

6.2 Czyszczenie 

6.2.1 Urządzenie CADIAX 

Sprawdź, czy urządzenie CADIAX jest odłączone od komputera. Odłącz również sensory od 
urządzenia. Usuń kurz i brud przy pomocy miękkiej szmatki. 

 

Nie używaj cieczy i dopilnuj, by żadna ciecz nie dostała się do wnętrza urządzenia podczas 
czyszczenia. Urządzenia nie wolno czyścić pod bieżącą wodą ani żadną cieczą. Nie używaj 
sztywnych szczotek ani wełny stalowej. 

 

Nigdy nie czyść urządzenia alkoholem, rozpuszczalnikami organicznymi ani środkami do 
dezynfekcji, ponieważ mogą one uszkodzić komponenty i obudowę. 

6.2.2 Płytki pomiarowe 

Powierzchnia płytki nie może być uszkodzona (np. zarysowana) ani zabrudzona (tłuszczem, kurzem, 
odciskami palców itp.). Przed każdym użyciem sprawdzaj stan powierzchni płytek. 

W razie potrzeby wyczyść powierzchnię płytki. W tym celu wytrzyj obszar pomiarowy alkoholem a 
następnie osusz miękką szmatką niepozostawiającą włókien. Po wyczyszczeniu płytki zostaw ją na 
wierzchu, aby całkiem wyschła. Dopilnuj, by podczas czyszczenia nie uszkodzić delikatnej powierzchni. 

 

Nigdy nie czyść płytek sztywną szczotkę ani żadnym innym materiałem ściernym. 

6.2.3 Rylce pomiarowe 

Wycieraj rylce tylko suchą szmatką bez włókien. W razie potrzeby wyczyść końcówki alkoholem. 

 

Nigdy nie smaruj gniazd i osi tłuszczem ani innymi środkami smarnymi. 

6.2.4 Łuk twarzowy 

Części łuku twarzowego mogą być dezynfekowane tylko sprayem lub przecieraniem środkiem 
dezynfekującym. Zmyj wszelkie pozostałości pod bieżącą wodą. Tylko wspornik nosowy może być 
sterylizowany w autoklawie (5 minut w 134°C; 20 minut w 120°C) 
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6.2.5 Zgryzowy uchwyt funkcjonalny 

Zdezynfekuj zgryzowy uchwyt funkcjonalny w zbiorniku do dezynfekcji lub zdezynfekuj sprayem. 
Następnie oczyść materiał rejestracyjny uchwytu. Sterylizację trzeba przeprowadzić w autoklawie (5 
minut w 134°C; 20 minut w 120°C). 

6.2.6 Zgryzowy uchwyt z łyżką wyciskową 

Zdezynfekuj łyżkę wyciskową uchwytu w zbiorniku do dezynfekcji lub zdezynfekuj sprayem. 
Następnie oczyść materiał rejestracyjny uchwytu. Sterylizację należy przeprowadzić w autoklawie (5 
minut w 134°C; 20 minut w 120°C). 

6.2.7 Widelec zgryzowy 

Zdezynfekuj widelec zgryzowy w zbiorniku do dezynfekcji lub zdezynfekuj sprayem. Następnie 
wyczyść cały materiał rejestracyjny. Jeśli użyto materiału termoplastycznego; zalecamy umieścić 
widelce zgryzowe w lodówce, aby ułatwić sobie usuwanie materiału rejestracyjnego. Sterylizację 
należy przeprowadzić w autoklawie (5 minut w 134°C; 20 minut w 120°C). 

6.2.8 Łącznik 3D 

Łącznik 3D można dezynfekować tylko przecierając szmatką zwilżoną w środku do dezynfekcji. 

 

Nigdy nie smaruj zawiasów łącznika 3D tłuszczem ani żadnymi innymi środkami smarnymi i 
nie zanurzaj tej części. 

6.3 Okresowe badania 

Jak inne urządzenia elektroniczne, tak również urządzenie CADIAX i jego elektroniczne komponenty 
starzeją się. W związku z tym funkcje pomiarów i bezpieczeństwo urządzenia należy regularnie 
kontrolować. Zalecamy wykonywanie przeglądów raz na ok. 

Badania bezpieczeństwa muszą zostać przeprowadzone zgodnie z normą IEC 62353 („Elektryczny 
sprzęt medyczny - Badania okresowe i badania po naprawie medycznych urządzeń elektrycznych”) 
lub z odpowiednią obowiązującą normą pochodną. 

W ramach badań okresowych należy mierzyć każdą różnicę w potencjale między narażonymi na 
dotykanie elementami przewodzącymi złączy. Każda wykryta różnica w potencjale wskazuje na 
awarię zabezpieczeń, którą należy skorygować. Te pomiary wykonuje się dodatkowo w stosunku do 
obowiązkowych badań wynikających z powyższej normy. 

Badania technologii pomiarów są przeprowadzane przez firmę GAMMA lub jej autoryzowany serwis. 

Płytki pomiarowe są silnie narażone na uszkodzenia mechaniczne i zużywają się. Należy je 
wymieniać po wykonaniu każdych 500 badań. 

6.4 Środowisko pracy 

Urządzenie jest przeznaczone do pracy w środowisku suchym. 

• Temperatura: od 10°C do 35°C. 

 

• Wilgotność względna od 10% do 85%, bez kondensacji. 
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W przypadku gwałtownej zmiany temperatury przed rozpoczęciem pracy odczekaj, aż urządzenie 
osiągnie temperaturę otoczenia. 

6.5 Przechowywanie i transport 

Jeśli urządzenie ma być transportowane na duże odległości, umieść je w oryginalnym opakowaniu. 
Przechowuj płytki i rylce w odpowiednich pojemnikach, gdy ich nie używasz. 

Warunki przechowywania i transportu powinny mieścić się w poniższych zakresach: 

• Temperatura: od -10°C do 60°C. 

 

• Wilgotność względna od 10% do 85%. Przechowywać w suchym miejscu! 

 

• Ciśnienie 
atmosferyczne: 

od 700 hPa do 1060 hPa. 

 
 

6.6 Zgodność elektromagnetyczna – wytyczne i deklaracja 
producenta 

6.6.1 Emisje elektromagnetyczne 

Urządzenie CADIAX jest przeznaczone do pracy w środowisku elektromagnetycznym o niżej podanej 
specyfikacji. Klient lub użytkownik powinien zagwarantować, że będzie ono używane tylko w takim 
środowisku. 

Testy emisji Zgodność Środowisko elektromagnetyczne - wytyczne 

Emisje RF 
zgodnie z CISPR 11 

Grupa 1 Urządzenie CADIAX korzysta z energii o częstotliwościach 
radiowych (RF) tylko do wykonywania funkcji wewnętrznych. 
W związku z tym jego emisje RF są bardzo niskie i nie 
powinny zakłócać pracy urządzeń elektronicznych 
znajdujących się w jego pobliżu. 

Emisje RF 
zgodnie z CISPR 11 

Klasa B Urządzenie CADIAX nadaje się do używania we wszystkich 
placówkach, również w domach mieszkalnych i budynkach 
bezpośrednio podłączonych do publicznej sieci zasilania 
niskiego napięcia dostarczającej prąd do budynków 
mieszkalnych. 

Emisje harmoniczne 
zgodnie z IEC 61000-3-2 

nie dotyczy 

Wahania napięcia/ emisje migotania 
zgodnie z IEC 61000-3-3 

nie dotyczy 

 (EN 60601-1-2, Tabela 201) 
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6.6.2 Odporność elektromagnetyczna 

Urządzenie CADIAX jest przeznaczone do używania w środowisku elektromagnetycznym o niżej 
podanej specyfikacji. Klient lub użytkownik powinien zagwarantować, że będzie ono używane tylko 
w takim środowisku. 

Test odporności Poziom testu EC 60601 Poziom zgodności Środowisko elektromagnetyczne - 
wytyczne 

Wyładowania 
elektrostatyczne (ESD) 
zgodnie z IEC 61000-4-2 

± 6 kV kontakt 

± 8 kV powietrze 

± 6 kV kontakt 

± 8 kV powietrze 

Podłogi powinny być drewniane, 
betonowe lub wyłożone płytkami 
ceramicznymi. Jeśli podłoga jest 
pokryta materiałem syntetycznym, 
względna wilgotność powinna 
wynosić przynajmniej 30 %. 

Odporność na 
szybkozmienne 
zakłócenia przejściowe 
zgodnie z IEC 61000-4-4 

± 2 kV dla linii zasilania 

± 1 kV dla linii wejścia/wyjścia 

± 1 kV dla linii 
wejścia/wyjścia 

Jakość sieci zasilania powinna być 
taka jak dla typowych pomieszczeń 
usługowych lub szpitalnych. 

Przepięcie 
zgodnie z IEC 61000-4-5 

± 1 kV 
linia(e) do linii 

± 2 kV 
linia(e) do ziemi 

nie dotyczy Jakość sieci zasilania powinna być 
taka jak dla typowych pomieszczeń 
usługowych lub szpitalnych. 

Zapady i krótkie 
zakłócenia i zmiany 
napięcia wejściowych 
linii zasilania 
zgodnie z IEC 61000-4-
11 

< 5 % UT 
(zapad > 95 % w UT) 
dla 1/2 cyklu 

40 % UT 
(zapad 60 % w UT) 
dla 5 cykli 

70 % UT 
(zapad 30 % w UT) 
dla 25 cykli 

< 5 % UT 
(zapad > 95 % w UT) 
dla 5 s 

nie dotyczy Jakość sieci zasilania powinna być 
taka jak dla typowych pomieszczeń 
usługowych lub szpitalnych. Jeśli 
użytkownik urządzenia CADIAX 
wymaga pracy ciągłej podczas 
zakłóceń zasilania sieciowego, 
zaleca się zasilanie urządzenia z 
UPS lub z baterii. 

Pole magnetyczne o 
częstotliwości zasilania 
(50/60 Hz)  
zgodnie z IEC 61000-4-8 

3 A/m 3 A/m Pola magnetyczne o częstotliwości 
zasilania powinny mieć poziom 
charakterystyczny dla typowego 
środowiska usługowego lub 
szpitalnego. 

Uwaga:  
UT jest napięciem sieci zasilania przed zastosowaniem poziomu testu. 

 (EN 60601-1-2, Tabela 202) 

Test odporności Poziom testu IEC 60601 Poziom zgodności Środowisko elektromagnetyczne - 
wytyczne 

   Minimalna odległość od którejkolwiek 
z części systemu CADIAX (w tym 
kabli), w jakiej powinny być używane 
przenośne i mobilne urządzenia 
komunikacyjne o RF jest równa 
zalecanej odległości minimalnej 
obliczanej z równania odpowiedniego 
dla częstotliwości nadajnika. 

   Zalecane odległości minimalne: 

Przewodzona RF 
zgodnie z IEC 61000-4-6 

3 VRMS 
150 kHz do 80 MHz 

3 VRMS  

Emitowana RF zgodnie z 
IEC 61000-4-3 

3 V/m 
80 MHz do 2.5 GHz 

3 V/m 
 

dla 80 MHz do 800 MHz 

 
dla 800 MHz do 2,5 GHz 
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   Gdzie P oznacza maksymalną 
znamionową moc wyjściową 
nadajnika w watach (W) podawaną 
przez producenta nadajnika, a d to 
zalecana minimalna odległość w 
metrach (m). 

Siły pola stałych nadajników RF 
wyznaczanych w badaniu terenu* nie 
powinny przekraczać poziomu 
zgodności dla żadnego zakresu 
częstotliwości. 

W pobliżu sprzętu oznaczonego 
poniższym symbolem mogą się 
pojawić interferencje:  

 

Uwaga 1:  
Przy 80 MHz i 800 MHz, zastosowanie ma wyższy zakres częstotliwości. 

Uwaga 2:  
Te wytyczne mogą nie mieć zastosowania we wszystkich sytuacjach. Propagacja elektromagnetyczna zależy od absorpcji i 
odbijania od struktur, przedmiotów i ludzi. 

a 
Siły pola stałych nadajników, takich jak radiowe telefoniczne stacje nadawcze (komórkowe/bezprzewodowe) i lądowe mobilne 
stacje radiowe, radia amatorskie, nadajniki radiowe Am i FM oraz nadajniki telewizyjne, nie można dokładnie oszacować 
teoretycznie. Aby uzyskać dostęp do parametrów środowiska elektromagnetycznego stałych nadajników RF należy 
przeprowadzić badanie w terenie. Jeśli zmierzone siły pola w miejscu, w którym używane jest urządzenie CADIAX 
przekraczają podany wyżej poziom zgodności RF, urządzenie należy obserwować pod kątem normalnej pracy. Po stwierdzeniu 
anomalii, konieczne mogą się okazać dodatkowe środki zapobiegawcze, takie jak zmiana kierunku ustawienia lub miejsca 
instalacji urządzenia. 

b 
Powyżej zakresu częstotliwości od 150 kHz do 80 MHz siły pola nie powinny przekraczać 3 V/m. 

 (EN 60601-1-2, Tabela 204) 

6.6.3 Zalecane minimalne odległości między przenośnymi i mobilnymi 
urządzeniami komunikacji RF a urządzeniem CADIAX 

Urządzenie CADIAX jest przeznaczone do używania w środowisku elektromagnetycznym 
o kontrolowanych zakłóceniach emitowanej RF. Klient lub użytkownik urządzenia może pomagać 
wyeliminować zakłócenia elektromagnetyczne utrzymując minimalną, zalecaną poniżej odległość 
między przenośnym i mobilnym sprzętem komunikacji działającym na częstotliwościach radiowych 
(nadajnikami) a urządzeniem CADIAX zgodnie z maksymalną mocą wyjściową sprzętu 
telekomunikacyjnego. 

Znamionowa maksymalna 
moc wyjściowa nadajnika 

[W] 

Minimalna odległość zgodnie z częstotliwością nadajnika [m] 

150 MHz do 80 MHz 

 

80 MHz do 800 MHz 

 

800 MHz do 2,5 MHz 

 

0,01 0,12 0,12 0,23 

0,1 0,37 0,37 0,74 

1 1,17 1,17 2,33 

10 3,69 3,69 7,38 

100 11,67 11,67 23,33 

Dla nadajników o maksymalnej wyjściowej mocy znamionowej innej niż wymienione powyżej zaleca się utrzymywanie 
odległości d w metrach (m) wyznaczonej przy pomocy równania odpowiedniego dla częstotliwości nadajnika, gdzie P oznacza 
maksymalną znamionową moc wyjściową nadajnika w watach (W) podawaną przez producenta nadajnika. 

Uwaga 1:  
Przy 80 MHz i 800 MHz, zastosowanie ma wyższy zakres częstotliwości. 
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Uwaga 2:  
Te wytyczne mogą nie mieć zastosowania we wszystkich sytuacjach. Propagacja elektromagnetyczna zależy od pochłaniania i 
odbijania od struktur, przedmiotów i ludzi. 

 (EN 60601-1-2, tabela 202) 

6.7 Utylizacja 

 

Po zakończeniu cyklu życia produktu, urządzenia CADIAX i jego komponenty należy 
prawidłowo zutylizować, postępując zgodnie z obowiązującymi krajowymi przepisami 
dotyczącymi utylizacji sprzętu elektronicznego. 
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